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Preface 
 

NOTE:  This document is in DRAFT form and is expected to have errors.  During this time, please direct 

all comments to the author. 

 

This documentation supplements and in some cases expands on the Opticks documentation found on 

the Help menu and online at the Opticks site.  The intent of this documentation is to provide the user 

with a logical overview of the application as well as some additional commentary on the tools, their use, 

and how they are used in for a particular purpose (e.g. identifying a particular cover type or material in 

an image requires a series of steps and a number of tools to complete the task). 

 

The Opticks User Guide begins with a general overview of the application, getting it set up and being 

able to load an image and becoming familiar with some of the tools and how to interact with the 

application interface.  The Opticks site provides a much more detailed explanation of the tools.  This 

document will explain the use of many of the tools as an analyst works through common and realistic 

image processing tasks as they relate to remotely sensed imagery. 

 

Users are encouraged to refer to both this document as well as the Opticks Help as needed to complete 

tasks.  Please submit comments, questions, errors, and issues to one of the following: 

 

nate@jenningsplanet.com 

jenninn@arc.losrios.edu 

users@opticks.ballforge.net (free registration is required to post comments to the Opticks forum) 

 

The user forum email can be found on the Opticks page under the Community section of the home page. 

 

http://opticks.org 
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Opticks – Getting Started 
 

See Help menu for a comprehensive explanation of the Opticks, toolbars, function descriptions and basic 

tutorial guides.  Most of these can orient the user with Opticks functionality.   Make sure to download 

the sample data sets or use images provided by the instructor. 

 

 

Setting up the Opticks Environment 
 

If Opticks is installed on a personal or standalone system, the default settings will likely be sufficient to 

perform the Opticks functions.  If Opticks is used in a lab where the user does not have write access to 

all of the default Opticks file paths, the following settings will need to be changed.  If the same user uses 

different computers, the settings may need to be set for each new user/machine. 

 

Using Opticks in a multi-user lab environment, the default options for Opticks may need to be changed.  

The Options are found under Tools—Options.  Some folders may need changing If users do not have 

write access to the default locations.  Users should check with a technology administrator to make sure 

the proper access to system folders is available. 

 

 

 
 

The following paths can be changed and set by the user to provide locations where users have 

read/write access.  Normally, the paths only need to be changed once; however, in some lab 

configurations, specific users may need to make the same changes if different machines are used. 
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For the Session—File Locations change the paths below as needed.  Write permission may be required 

for some locations. 

 

 
 

 

Loading Custom Plug-ins (Opticks Extensions) 
 

Plug-ins are additional code packages that extend the core functionality of Opticks.  These are custom 

built applications developed in C++ by the Opticks open source community and delivered as either 

compiled dynamic link libraries (DLLs) or from compressed files (AEB – similar to the zip format).  A few 

plug-ins exist for Opticks (Spectral Processing, Python, RADAR, and SAR (Synthetic Aperture RADAR) that 

are not part of the core functionality of Opticks.  Before downloading and installing plug-ins make not of 

the installed Opticks version and the Plug-ins version number.  Plug-ins support specific versions of 

Opticks.  Some plug-in versions are not forward or backward compatible.  The Opticks Extension site will 

indicate which Opticks version is supported. 

 

Three methods exist to load extensions. 

 

1. Install Extensions for the Help menu.  Once the AEB files are downloaded, users can install the 

extensions by going to the help menu and choosing install.  The installed extensions will show up 

under the help menu. 
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2. Drag/Drop AEB onto Opticks.  Users can download the extensions from the Opticks site and 

simply drag and drop the AEB extension into any location on Opticks when the application is 

open.  The AEB will extract and load in the proper location for Opticks to recognize it. 

 

When AEB files are installed, users will see the installed extensions under the Help menu. 

 

3. Copy DLL file to Opticks Plug-in directory. Download and open the zip file containing the DLL file 

from the Opticks extension site.  Copy the DLL file the C:\Program Files\Opticks\<Opticks 

version>\Plug-ins folder.  When Opticks is open, typically a new toolbar will appear in the 

Session Explorer.  Also, the user will see the DLL file show up in the Plug-ins Tab.  
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In either case, the user can check the respective Toolbar from the Session Explorer to load the toolbar if 

one exists for the plugin.  Make sure to read any documentation that accompanies the plug in. 

 

Saving an Opticks Session 
 

To save an Opticks Session (similar to a project file), the user can choose File—Save Session As (or Save 

Session if an Opticks Session already exists) and assign a session name.  The Opticks Sessions will have 

an extension of .Session and an Opticks Session folder (.SessionDir) will be created in Windows Explorer.  

The SessionDir contains a number of files that keep track of imagery and settings used in the respective 

session.  Image files do not have to be stored in the same directory as the Opticks Session. 

 

Drag and Drop AEB files here from 

Windows Explorer. 

The DLL files automatically install. 

The DLL files that are installed 

show up here 
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Customizing Opticks Options 
 

The user can also make modifications to some of the Options within Opticks such as units, colors, and 

custom band combinations. 

 

Creating a Custom Band Combination 
 

1. Under the Tools—Options menu, select Raster under the Layers Options. 
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2. Click on the Add button on the Color Composites portion of the Options window. 

 

3. Make the following changes by highlighting on each element to rename the New Composite and 

assign band combinations.  If wavelengths are known, these can also be added if necessary. 
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Using the New Band Combination 
 

When users import or display imagery, this new color composite will be available. 

 

Displaying Toolbars 
 

Tool bars for Opticks are usually displayed at the top of the application.  Additional Toolbars can be 

added by doing the following: 

 

1.  Click on the Toolbars menu in the Session Explorer 

 

 
 

2.  Check the respective box to display the toolbar 

 

 

Toolbar Overview 
 

This section provides a brief overview of each Opticks Toolbar (checked below).  Unchecked toolbars are 

not covered in this document.  See the Help menu for more details on the tool.   Other sections in this 

guide will have additional details on respective tools as they are discussed.  Some toolbars are not 

activated until an image or other feature is loaded into Opticks.  Hover the mouse over a specific tool to 
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see the name of the tool.  Also, look at the lower left corner of the Opticks Application window to see a 

short description of the tool. 

 

 
 

AOI 
 

The AOI (Area of Interest) tool allows the user to create small areas on the image to perform additional 

operations such as create subsets, limit processing areas, and work with spectral signatures.  An AOI 

layer must be created or exist to activate the toolbar.  Some of the AOI tools are used with the Spectral 

Processing Toolbar as well as with processing multispectral and Hyperspectral imagery. 

 

 
 

Annotation 
 

The Annotation Toolbar used to add text, and other information to the image display for a simple map 

to be produced.  An annotation layer must be created or exist to activate the toolbar. 

 

 
 

Brightness 
 

The Brightness toolbar allows the brightness and contrast of the current image window to change.  An 

image must be loaded into the image viewer to activate this toolbar. 
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Display 
 

The display toolbar provides the primary navigation functions for zoom in/out/full extent, pan, and 

various image rotation options. 

 

 
 

General Algorithms 
 

The General Algorithms provide some basic image manipulation options.  An image must be loaded to 

operate many of the functions within this toolbar. 

 

 
 

Band Math 

 

Provides options to perform basic math functions between different image bands (e.g. addition, 

subtractions, divide (band ratios), multiply, etc). 

 

 
 

Change Up Direction 
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This function allows the user to change the up direction to always be at the top of the image.  For 

example, if a satellite has a southern orbital path, the southern part of an image may be at the top and 

appear “upside down.”  Users can change this direction if required. 

 

Data Fusion 

 

This function allows for two different images to be combined into a single image space or to integrate 

higher resolution imagery with lower resolution imagery. 

 

Flatten Annotation Layer 

 

This option is not yet documented. 

 

Principle Component Analysis 

 

This function runs a principle component analysis routine.  Principle Components often is used to reduce 

the number of bands required for image processing as well as performing some change detection 

operations.  Consult a Remote Sensing textbook for more details. 

 

QT Cluster 

 

This option is not yet documented. 

 

Geo 
 

The Geo Toolbar provides the ability to assign a georeference (coordinate system) to the image.  

Georeferencing is discussed in more details below.  Images must have a related set of ground control 

(GCPs) for the georeference to be assigned.   The toolbar provides some basic ability to add GCPs.  

Latitude/Longitude, UTM, and MGRS (Military Grid Reference System) coordinate systems are 

supported. 

 

 
 

Geographic Features 
 

The Geographic Features toolbar provides the ability to load GIS shapefiles or geodatabases (including 

ArcSDE enterprise grade geodatabases). 

 

 
 

Measurement 

 

The Measurement Toolbar allows measurements to be made and displayed on the image.  An image 

must be loaded and georeferenced to use this toolbar.  Also the Measurement Mode button must be 

clicked. 
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Spectral Processing 
 

The Spectral Processing Toolbar provides several tools and algorithms for processing hyperspectral data 

and creating spectral signatures for identifying different materials from hyperspectral (or other 

imagery).  The Spectral Signature capability is provided by the Spectral Processing Extension.   An image 

must be loaded into the viewer and some functions require the spectral values to be represented as 

radiance or percent reflectance as well as know the specific wavelengths for each band.  Often 

hyperspectral data is provided with radiance or percent reflectance whereas other non-hyperspectral 

imagery is represented with a brightness value relative to the materials reflectance.  Specific functions 

on the spectral toolbar are discussed in the Hyperspectral section.  See Appendix B for a full description 

of the Spectral Processing Extension. 

 

 
 

 

Standard 
 

The Standard Toolbar provides the ability to open or import a variety of image and vector data types.  A 

link is also provided to access the Opticks Help. 

 

 
 

Tie Point 
 

The Tie Point Toolbar provides some ability to collect additional points in image data so that some basic 

image rectification can be performed. 

 

 
 

Toolbox 
 

The Toolbox Toolbar is another primary toolbar that is used often in Opticks.  It provides the capability 

to view histograms of image bands, loads the Session Explorer, load a scripting window to run custom 

scripts, create image subsets (image chips), link image viewers, and activate the layer edit mode that 

activates the AOI tools 
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Working with Imagery in Opticks 
 

To use Opticks, image data must be loaded into the application.  This can be achieved by going to File—

Import Data and then search for image data or the Import Tool (Open Folder button) on the Standard 

Toolbar.  Since a variety of imagery can be loaded (panchromatic  [i.e. single band black and white], true 

color, multi-spectral, or hyperspectral), it can be loaded and viewed either as a single band image or 3 of 

the multi-spectral or hyperspectral data can be assigned to the RGB colors of the color display.  By 

default, multi-spectral data not already saved into an Opticks session will display as black and white.  

The user will need to change the display to assign specific bands or wavelengths to the RGB color 

display. 

 

Opticks supports a number of raw and common file remote sensing image formats.  Some are sensor 

specific, while others are in common delivered format (TIF, ERDAS Imagine, ENVI, NITF, HDR).  Opticks 

has its own image format called ICE (Image Cube).  Data can be saved and exported to this format.  

Other image processing software may not be able to read this format.  It is recommended to save data 

to a more common format (e.g. TIF). 

 

Display an Image 
 

Click on the Import Data Tool 

 

 
 

Select the specific file format and location of the file. 

 

 
 

The Options button brings up an additional dialog box that allows the user to select specific bands of the 

image and assign them to RGB display colors, otherwise, the image will display as a grayscale image (the 

default). 

 

Choose the appropriate file 

format. 

Common formats are: GeoTIFF 

(TIF), BSQ, BIP, BIL, ERDAS 

Imagine, ENVI, HDR, NITF) 
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The user can change the band combination at any time by bringing up the image properties from the 

Session Window and then right click on the image file. 

 

Image Properties 
 

RGB display colors can be 

assigned to specific sensor 

bands.  The Display mode can 

also be set to RGB to display 

color. 

NOTE:  Display mode must be 

set to RGB to see the color 

assignment. 
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Band assignments, display mode, and image stretch can be changed in the image properties dialog box. 

Right click on the image and 

then select Properties to bring 

up the image properties. 
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If the all of the display bands indicate the same band number, then the image will display in grayscale 

(black and white), even if the image is multi-band.   

 

 

Reviewing Metadata about the Image 
 

Information about an image can be viewed at the time of import or loading into Opticks or through the 

Elements Tab in the Session Window. 
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Refer to the Data Elements Properties in the Opticks Help for additional information. 

 

Data Tab 

 

This tab shows the basic information about the image (bands, rows, columns, data type, pixel size, etc.). 

 

 
 

File Tab 

 

This tab also contains much of the same information found in the Data Tab and also contains any ground 

control points (GCPs) that is used to place the imagery in geographic space. 

Right click on the image, and 

select properties to view 

metadata 
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Metadata Tab 

 

The metadata tab provides information about the wavelengths that are used in the current display. 

 

 
 

Wavelengths Tab 

 

The wavelengths tab provides information about the specific wavelengths for each band in the full 

image file.  The wavelegnths can be displayed in micrson, nanometers, or inverse centimeters. 
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Subset an Image 
 

Users may not want to import an entire image into Opticks, especially if the image is very large (> 1 Gb) 

or I there are a large number of bands and some are known to not contain very useful information (such 

as hyperspectral data with the water vapor absorption bands removed).  Two options are available to 

limit the number of bands and spatial extent of the image during import.  See the Opticks Tutorial on 

Spectral and Spatial Subset for additional details. 

  

Band Subset 
 

An easy way to subset an image containing a smaller number of bands than the original is to select (or 

ignore) bands from the input image using the Options button on the Import dialog box. 
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Notice that the imported image shows 3 bands 

 

Choose the bands to import.  

Unselected bands are not 

imported. 



25 

 

 
 

The imported file still indicates 6 bands in the original image file. 
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If the remaining defaults are chosen, then the image will display as gray scale.  The user can use 

methods described above to change the band combination and to display the image as RGB (i.e. as a 

color display). 

 

Spatially Subset Image 
 

In addition to the above, the user can also limit the spatial extent of the image by using the Preview 

button in the Import window. 

 

 
 

Use the tool provided to select a rectangular area to subset the image by the extent of the rectangle.  

Using this method in addition to the Band Subset can limit both the number of bands and the spatial 

extent of the imported image at the same time. 
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After the image is imported, the following viewer appears with the both the number of bands and the 

spatial extents reduced. 

 

 
 

If the user changes the band combination, the new imported file may look like this. 

 

 
 

 

 

Working with Histograms 
 

Histograms are graphical representations of data.  In the case of remotely sensed imagery histograms 

represent the distribution of pixel values for a given spectral band.  Opticks can display histograms for 

spectral bands.  The values along the X axis may represent the brightness range (intensity levels) of an 

image and the Y axis represents the total count for a given brightness value.  For more information see 

the Opticks Help under Opticks Studio—Working with Opticks Windows—Histogram Window. 

 

Viewing a Histogram 

 

To view the histogram for a band of the active image viewer, click on the Histogram tool on the Toolbox 

toolbar.  
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Alternatively, the user can expand the Dock Windows element under the Session Explorer, and then 

expand the respective image.   Check the box for the Histogram Window to display the histogram for the 

active image. 

 

 
 

The Histogram tools loads a graphic display for one or more of the bands in the active image.  If the user 

has only a gray scale image displayed a single histogram shows up like this. 
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If the image is a multiband image the user can right click in the Histogram Window and choose the 

Displayed Band.  Select a different band to change the histogram. 

 

 
 

Choose a different band to 

change the histogram 
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If a multiband image is displayed as color a histogram is displayed like this. 

 

 
 

Notice the three tabs at the bottom of the histogram indicating the Red, Green, and Blue bands.  When 

each color tab is clicked, the respective histogram is displayed.  Notice the Band number at the top of 

the Histogram Window.  Users can change the band assignment for a given color by right clicking in the 

Histogram Window and change the Displayed Band as described above.  The displayed window will also 

change. 

 

Changing the Contrast 

 

Users can also change the stretch of the active image by left-clicking (or left-click hold and drag) on the 

left or right side of the colored area in the Histogram Window.  The image will change in contrast. 

 

Changing the Image Stretch 

 

Different kinds of image stretches can also be applied to the image by using the Histogram Window.  

Applying an image stretch to an image can enhance different areas within an image.  A typical image 

stretch for remotely sensed image is a two standard deviation stretch following a linear function.  

Different types of image stretches and units can be used per band while using the Histogram Window.  

Right-click in the Histogram window to access these options. 

 



31 

 

 
 

Linear – typically the default stretch and follows a linear function.  The data is stretched in a linear 

fashion from low values to high values and tends to apply a stretch evenly across the image. 

 

Exponential – follows an exponential curve.  This stretch tends to suppress darker areas and enhance 

brighter areas. 

 

Logarithmic – follows a logarithmic curve.  This stretch tends to suppress brighter values and enhance 

darker values. 

 

Histogram Equalization – this stretch attempts to place an equal number of pixels to a specific number 

of spectral categories across the brightness range.  The effect of this stretch tends to make the brighter 

areas just a little brighter and the darker areas just a little darker.  The brighter areas can look a little 

more washed out.  

 

An image stretch can also be changed by right-clicking on the image file in the Session Explorer. 

 

 
 

The stretch units can also be changed. 
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Hyperspectral Processing with Opticks 

 

Overview 

 

Processing hyperspectral imagery is usually an involved process and often requires a number of 

preprocessing steps before any image analysis (usually material identification) can take place.  Opticks 

uses the Spectral Processing Tools to accomplish these tasks.  See Appendix XX for specific details of this 

tool set.  The hyperspectral processing section describes some of the basic tasks an analyst usually 

implements to conduct material identification. 

Hypespectral imagery is becoming more available and affordable for organizations.  Since hyperspectral 

usually requires special skills in image acquisition, identifying physical, chemical, and geographic 

properties of materials, and strong skills in image interpretation and analysis, image analysts usually 

need additional education and training.  Opticks provides a strong overview of the tasks and is 

continuing to develop functionality for spectral signature analysis and processing.   

Opticks offers the following hyperspectral image processing capability which primarily uses the Spectral 

Processing tools and algorithms, including the Signature Window and the AOI tools (to assist with some 

of the signature and preprocessing tasks). 

1. Preprocessing 

 

a. Bad Band Identification – Minimum Noise Fraction 

b. Atmospheric Correction – Empirical Line Method and Internal Average Relative 

Reflectance 

 

2. Material Identification -  Constrained Energy Minimization and Spectral Angle Mapper 

Future releases of Opticks expect to have some additional Signature Library comparison capability. 

Sample Imagery 
 

The sample image used in this tutorial is from NASA’s AVIRIS airborne sensor (http://aviris.jpl.nasa.gov) 

and SpecTIR, an airborne hyperspectral sensor operated by the SpecTIR company, www.spectir.com.  

The Spectral sample imagery is from the Suwannee National Wildlife Refuge collected just before oil 

from the Deep Water Horizon came ashore.  See the website above to download the imagery.  The 

sensor collects 360 specific wavelengths between 400 and 2500 nm with a single “band” representing ~ 

5 nm width/band.  The SpecTIR image can only be used for training and evaluation.  Contact SpecTIR for 

additional limitations and additional sample data.  The AVIRIS imagery can be obtained through NASA or 

Opticks at http://opticks.org.  
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NOTE:  It is recommended to use subsets of data to work through the development of the image 

processing steps and parameters (such as threshold values, etc). 

Pre-requisite 

Make sure to load the Spectral Processing Extension.  See Appendix A for more information and a 

discussion of the tools and algorithms. 

Load the Hyperspectral Image 

 

Several options can be chosen as part of loading an image into Opticks.  In the case of an ENVI or Opticks 

(ICE) format image, wavelength data can be directly associated with the imagery.  Since so many bands 

exist with hyperspectral data, a couple of options exist for providing some default band display (NIR, 

SWIR, RGB, etc).  In addition, to reduce the quantity of data loaded into memory, the analyst can choose 

to subset the image (virtually) by drawing a box around a portion of the full image (Spatial Subset).  Also, 

since some hyperspectral data may have “bad bands” represented by a “salt and pepper” effect, the 

user can choose to ignore these bands, provided they are known before loading the image.  In some 

cases, some general image review is needed to determine how the hyperspectral data can best be 

loaded.  Once an Opticks Session is saved, these settings are loaded when the analyst opens the saved 

session. 

The Suwannee-0609-1331.hdr (and .DAT file) is used in this tutorial.  The imagery can be downloaded 

from www.spectir.com or from a local network.  For the American River College Ethan Way Lab, this 

image can be found here: 

N:\geog 342\imagery\hyperspectral\spectir 

Use the Import data (folder or tool from the File menu).  Change the path to the location of the image 

data. 
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A number of files exist for the Suwannee image.  Choose the Suwanee_0609-1331_ref.hdr file.  The .hdr 

file is a header file that contains the bands, rows, and columns information for the image.  The actual 

image has the .dat extension (notice the file size is much larger). 

Spatial Subset (Optional) 
 

Since hyperspectral imagery is typically quite large, the user can “subset” the imagery to a smaller 

geographic extent.  For this tutorial, the user will subset the imagery for extra practice. 

The user can use the “preview” tool to bring up a preview image of the scene.  The Zoom by Extent tool 

can be used to select a subset of the larger image to view in Opticks.  The spatial subset only loads the 

selected area of the image into Opticks.  If the user wants to save this subset, follow the procedure 

below.  
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Zoom to an area of interest.  When the cursor is placed in the preview area, the cursor will look like 

the zoom to extent tool  . 

 

The image will zoom to this extent. 

Review the Image Information 

Preview Button 
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Image analysts should review the image data before using it.  Opticks provides a number of tabs that 

provide an overview of image characteristics such as rows, columns, bands, wavelengths, etc.  Use the 

following options to review the imagery before opening in Opticks. 

1. Click Options 

2. Click on each of the tabs to review the information about the image. 

Data Tab 
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File Tab 

 

 

Subset Tab 

 

This tab provides information about the area chosen in the Spatial Subset if an area was chosen.  In 

addition, if bands were “ignored” they will show up as “not highlighted” in the subset tab. 

 

Bands not loaded are not highlighted.  This is optional. 
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Click on Custom Selection to load a text file that contains a list of “bad bands.”  This might be helpful 

to create if a number of images required these bands to be removed.  In some cases, the “bad 

bands” may correlate to specific wavelengths of the spectrum such as water or carbon dioxide 

absorption.  In the case of SpecTIR imagery, the company has developed methods to maintain as 

much of the original data as possible while keeping the quality of the image data high.  In most 

cases, end users do not need to remove “bad bands.” 

 

Load the text file. 
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Metadata Tab 
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Wavelengths 

 

 

Notice that by changing the units of Microns, Nanometers, or Inverse Centimeters.  Most of the time 

units will be microns or nanometers. 

Load Wavelengths from File (Optional) 

Optionally, if an image does not have wavelength values by default, a text file can be created that 

contains the information above.  Two formats are possible:  1) WMD – wave metadata file (ENVI format) 

and 2) .wave (.wav or .wave) which is a plain ascii format.  As an example for the .wav format, the 

following was created for an AVIRIS image which has 224 bands.   

A text file was created with the following information obtained from 

http://www.csr.utexas.edu/rs/sensors/spectral_94_all.ascii.   Some minor modifications were 

performed in Excel and then exported out to a generic comma delimited text file.  The following format 

is required to properly load into Opticks.  NOTE:  These are approximate values for an AVIRIS image file.  

Ideally, validated wavelengths values from the image source will be obtained. 
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This text file can be loaded into the Wavelength tab by choosing Load from above and finding the 

specific wavelength file. 

3. Click back on the Data Tab.  

 

4. Click the Set Display Bands.  The user can choose a default band combination.  NIR (Near 

Infrared) is provided by Opticks.  Although SWIR (short wave infrared) is provided by Opticks, it 

may not work for all image data sets.  The Landsat 453 is a custom band combination created 

and stored by the user.  See the Customizing Opticks Options for more information. 

 

5. Choose NIR.  Click OK.   

 

6. Click Open from the Import dialog box. 
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The image begins to load. 
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7. Click on the Workspace Windows from the Session Explorer to see that the .DAT file is loaded. 

 

Remove Bad Data (Minimum Noise Fraction) 
 

Under Development.  Future Updates will have this section documented.  Check www.jenningsplanet 

(Training and Tutorials) for future updates. 

 

 

Atmospheric Correction 
 

Two algorithms exist in Opticks for performing atmospheric correction.  Since objects reflect energy 

back to the sensor, some of it interacts with water vapor and other gases, thus preventing the sensor of 

capturing the “actual” surface reflectance of the object. Atmospheric correction can accommodate for 

some of these effects.  Opticks provides two methods for performing atmospheric correction. 

Empirical Line Method (ELM) 

 

Under Development.  Future Updates will have this section documented.  Check www.jenningsplanet 

(Training and Tutorials) for future updates. 

Internal Average Relative Reflectance (IARR) 

 

The IARR method uses an overall average of radiance values that can be applied to all of the image 

bands.  This method does not require any field measurements or bright and dark pixel assignments.  This 

method is not considered very robust and is mostly useful for areas that have little or no vegetation. 

Use a radiance file for the input image.  Typically the defaults can be accepted.  An output .IARR file will 

be generated that stores the output reflectance file.  This file can then be used for subsequent material 

identification. 
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Once the IARR file is generated, the analyst can compare radiance and reflectance values from the 

two different images.  The Display Pixel Signature Tool can be used from the Spectral Toolbar to 

evaluate image spectra from different locations throughout the radiance and reflectance image. 

Uncorrected Radiance Image 

 

 

 

 

 

 

 

 

 

 

 

Raw Radiance Image 

Radiance 

Spectra is from 

center pixel below 
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IARR Image Corrected for Atmospheric Effects 

 

 

 

Material Identification 
 

After the various corrections are complete, the hyperspectral imagery is ready for use primarily to 

detect the geographic occurrence of different kinds of materials such as specific vegetation types, 

minerals, geologic features, contaminants, etc. 

 

The hyperspectral imagery should have wavelength information available.  If the image does not load 

the wavelength values by default, see the Spectral Processing Extension (see Wavelengths) below to 

learn how to generate a file that can be used to with the image data.  The image needs to be loaded into 

an Opticks Viewer. 

 

Two material identification methods are available in Opticks:  1) Constrained Energy Minimization and 2) 

Spectral Angle Mapper.  The process below shows the process an analyst needs to perform to conduct a 

material identification.  The image below is for demonstration purposes only. 

 

Before using either algorithm, a pixel or area of interest must be selected for evaluation. 

 

Constrained Energy Minimization 

 

IARR Corrected Image 

Reflectance 

Spectra is from 

center pixel below 
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Under Development.  Future Updates will have this section documented.  Check www.jenningsplanet 

(Training and Tutorials) for future updates. 

 

Spectral Angle Mapper 

 

1. Zoom to an area of interest in the image. 

 

2. Use the Display Pixel Signature tool or use the AOI tools to generate an AOI and then generate a 

spectral signature from it.  For example, the image can be zoomed to the area shown in red, 

then the Display Pixel Signature tool can be used to select a pixel to generate a spectral curve 

shown below. 

 

 
 

For example, click on a pixel (236, 1004) in the above image to bring up a spectral curve for the selected 

pixel.  Look in the lower right to see the row and column of the cursor.  Note the pixel row and column; 

it will be needed in the next step to run the Spectral Angle Mapper algorithm.  Alternatively, the user 

can show the legend in the signature window (Right click in the Signature Window—Legend) to show the 

row and column of each spectral signature. 
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Signature Window with Legend shown. 

 

 
 

3. Click on the Spectral Toolbar—Material ID—SAM. 

4. Choose the pixel above from the Signature list. 

 

 
 

 

5. Click OK.  If the identified pixels look like little “+”, right click on the SAM Results and select 

properties and change the marker to a filled in square.  Change the color if desired. 
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The results of the SAM algorithm are shown below for the local area where the pixel was chosen.  

Zoom out and pan around to see the geographic extent of the SAM results. 

 

 
 

 

To process more than one material type at a time, select different cover types to identify in the image 

using the Display Signature tool.  Multiple spectral curves will appear in the Signature Window.  See the 

example Signature Window above.  Click on the Spectral Tools—Material ID – SAM to identify the 

material. 

 

NOTE:  This will likely take a little longer than a single material type.  It is recommended to use smaller 

subsets of the image to develop and refine the processing steps an parameters (such as threshold 

values, etc). 
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Notice the progress meter shows which signature is being processed. 

 

 
 

The resulting SAM Layer has multiple colors shown (i.e. a pseudo color layer). 
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The colors and display type can be changed by right clicking on the SAM Results in the Workspace 

Window.  The name of the class can also be changed by clicking on the name and providing an alternate 

name. 
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Appendix A - Spectral Processing Extension 

 

The Spectral Processing Extension is a plug-in created by the Opticks team that provide some spectral 

analysis capabilities for multispectral and hyperspectral image data.  Most of the functions are used with 

hyperspectral data for pre-processing or material identification.  See the Hyperspectral section for more 

details to use some of the spectral tools and algorithms.  The KMeans classification algorithm is 

currently in draft form for Opticks version 4.4.x with its primary function being a semi-automated 

(hybrid of unsupervised and supervised methods) classification algorithm. 

Install the Spectral Processing Extension 

 

Drag and Drop the Spectral.AEB file into Opticks or go to the Opticks Help—Extensions—Install to install 

the AEB file.  The spectral Toolbar will be loaded.  Users will likely need to restart Opticks for the new 

extension to appear.  After the extension is installed, the user will see the following dialog box from the 

Help—Extensions menu item. 

 

Spectral Toolbar 

 

The Spectral Toolbar contains both algorithms (image processing functions) and some tools to use with 

image data and spectral signatures. 
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The spectral tools are used to create, view, and evaluate spectral signatures created by the user.  The 

spectral signatures will be used in algorithms to categorize other pixels in the image containing the same 

material.  The Signature Window will often be used in conjunction with these tools. 

Spectral Tools 

 

 

From left to right the tools are: 

Show Signature Window  

 

The window is typically for the active image viewer 

 

 

 

Pin/Unpin Signature Window  

 

Creates a custom plot area to capture spectral signatures from different image windows.  Images must 

have the same kind of units (bands or wavelengths) to display in this plot. 
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Create a spectral signature with the mouse 

 

Click inside an image window with this tool to generate a spectral signature, similar to those shown 

above. 

 

Display AOI and average signature  

 

Displays both the individual signature of each pixel in the AOI as well as the average signature of the 

pixels in the current AOI.  This plot requires an AOI to exist in an image viewer.  The signature plot is 

derived from the pixels within the AOI.  Each black spectral curve represents each pixel spectra.  The red 

curve represents the average spectra of the pixels in the AOI. 

 

 

 

Display Average Signature of AOI 

 

Displays the average signature of all the pixels in the current AOI.  The red curve represents the average 

spectral for all of the pixels within the AOI. 
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Spectral Algorithms 

 

 

Material ID  

 

Material ID contains two different functions that can be used to identify material types within the image 

a. CEM – Constrained Energy Minimization 

b. SAM – Spectral Angle Mapper 

Preprocessing  

 

Preprocessing contains two different functions to perform some pre-processing on a raw hyperspectral 

image.  These are two methods of converting radiance values (often captured by the sensor) to 

reflectivity values (often used by the end user) for image analysis.  These are considered atmospheric 
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correction methods that correct for water and various atmospheric gases that affect the “reflectance” of 

objects back to the sensor. 

a. ELM – Empirical Line Method 

b. IARR – Internal Average Relative Reflectance 

Classification  

 

This is the Draft KMeans algorithm and is not officially released by Opticks.  

Transforms  

 

This option contains the Minimum Noise Fraction (MNF) for both Inverse and Reverse transforms.  This 

function is often used as a pre-processing step for hyperspectral data to remove some noise that is 

inherent in the image before further processing is completed. 

NOTE:  NDVI is and will be a transform function that will eventually be removed from this toolset and 

placed on a different tool set.  Refer to the Ratio Wizards in Appendix A that show a number of ratios, 

including NDVI. 

Support Tools 

 

Support Tools contains the Spectral Library Builder and the Spectral Signature Window.  The window can 

also be activated from the toolset described above.  The spectral library builder can be used to generate, 

save, and import/export spectral signatures for use in material identification. 

 



57 

 

Appendix B – Creating and Using Wizards 
 

Wizards 

 

Wizards in Opticks allow the user to develop and create a process (i.e. a workflow or model) and then 

can reuse it for different inputs and outputs.  Wizards can assist with improving productivity of 

repetitive tasks and can also add functionality to Opticks without requiring any special programming 

skills.  Wizards can be executed in various ways such as within the Wizard Builder, from a custom toolbar 

and menu list, or externally by running a command or batch file. 

 

Using Wizards for Common Tasks 

 

Some Image processing tasks that are not part of the core Opticks functionality are good options for 

creating a wizard.  One such example is the creating band ratios using the Band Math Tool.  Ratios can 

be computed using the Band Math Tool, but this is typically a single operation and the user cannot save 

the math expression without copying and saving it to an external file.  This can be cumbersome since the 

expression can be complex.  One alternative to expanding the flexibility of the Band Math Tool is to 

incorporate it into a custom wizard where the user can develop the algorithm one time and then reuse it 

for different kinds of images. 

 

Building a Wizard 

 

To create a custom wizard, the Wizard Builder is used.  The Wizard Builder is started from Tools—

Wizard Builder.  The Wizard Builder is displayed. 

 

 

Processing objects 

and groups of 

objects 

Wizard Builder 

Canvas (Processing 

objects go here) 

Wizard Menu 

Location 

Wizard and 

Object Execution 

Mode 
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A set of processing objects are displayed on the left side.  These are used to build the model and show 

up in the middle section.  The right side of the Wizard Builder is used to determine how a process will be 

executed (interactive through user input or batch mode for automating tasks) as well as changing the 

order of objects and indicating if a custom toolbar will be created with menu options to run the wizard. 

 

An example of a simple model is shown below. 

 

 
 

This model shows the Band Math Tool as well as a Get Raster Element object to solicit an image file that 

is already open in Opticks as well as the actual math expression (e.g. NDVI) that the Band Math Tool 

uses.  The model also includes objects to solicit an output file name from the user and the file will be 

exported using the TIF format.   

 

The Execution Mode (upper right) is set to Interactive indicating the tool will require some user input to 

run to the tool.  If the execution mode was set to Batch, the user would click the menu option (or the 

Execute button in the Wizard) and the process would run without user interaction.  Notice on the upper 

right that a menu location has been set to: 

 

[Ratios]/NDVI 

 

This structure indicates that a tool bar called “Ratios” will be used and /NDVI indicates a menu option 

under the Ratio tool bar.   
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NOTE:  For Opticks to properly use the custom toolbars the Wizard Path must be set and the wizard files 

must reside in this folder.  Below, the Wizard Path is set to C:\temp, but this can be changed by the user 

under Tools—Options. 

 

 

 
 

 

The processing objects above are numbered indicating the order in which they are used.  The first object 

is the Get Raster Element.  The Get Raster Element allows the user to choose an existing file that has 

been imported into Opticks.  Alternatively, Import Data Set (i.e. an input file that is not currently 

displayed in Opticks and solicited from the user by making the object Interactive) can be used.  If the 

image already is open in Opticks, the user will be shown a message that the image is already loaded.  

The second object is the math expression.   Both objects are required to run the Band Math Tool (third 

object), since the Band Math tool requires an image (i.e. an image cube) and an expression for the tool 

to operate. 

 

Also note the different colored outlines on the objects.   

 

1. Black indicates an interactive object (one that requires user input) 

2. Red indicates batch mode (that does not require user input) 

 

Each object in the Wizard Builder can have different modes of operation similar to that of the entire 

model.  In the example above, two interactive objects exist:   

 

1) the input file (Get Raster Element) 

2) the Output File name (a name provided by the user and will have the TIF extension) 

 

Four batch objects exist in the model and will not have any user interaction:   

 

1) the math expression  

2) the actual processing of the math expressions through the use of the Band Math Tool 

3) create File Export Description (this sets up the export function to tell Opticks an output file will be 

generated 

4) the kind of exporter (in this case a GeoTIFF export type) 
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The inputs to the model are: 

 

1. Input Raster (already opened within Opticks) 

2. Math expression 

3. Band Math Tool 

The outputs to the model are: 

 

1. Output GeoTIFF that requires: 

 

1. File name 

2. Export descriptor 

 

Note that the Band Math Tool has two green lines, one going to the Export File Descriptor and one going 

to the GeoTIFF Exporter.  Both the Export File Descriptor and GeoTIFF Exporter need to know that an 

image file, in this case the output raster of the Band Math Tool.  The Export File Descriptor is connected 

to the GeoTIFF Exporter so that the GeoTIFF Exporter knows the specific kind of export file to create. 

 

The exact same structure can be used for any Band Math function, with these changes: 

 

1. The specific math function 

2. The output filename  

 

Alternatively, the user can modify the model to also solicit any valid input file, provided it is not already 

imported into Opticks. 

 

In the model above, the user can choose to not write (save) an output file and the output from the Band 

Math Tool will appear in a new window in Opticks.  The user can save the image at a later time. 

 

Updating the Wizard List 

 

Before Opticks is aware of any new changes to a Wizard or Wizard Toolbar, the Update Wizard List 

menu option must be checked to refresh the Wizard List (Tools—Update Wizard List). 

 

The following ratios were added as part of the “Ratios” toolbar.  
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Each of the specific ratios is a separate Wizard (.wiz files) although they all show up under the Ratios 

toolbar because they have the same [Ratios] toolbar placement and all of the .wiz files exist in the same 

directory (set by the Wizard Path under Options). 

 

The ratios are common to Landsat TM.  Additional ratios can easily be added and other menu options 

created for different sensors. 

 


